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Overview

VIVOTEK’s FE9391-EHV-v2 is an H.265 fisheye network cameras featuring a detailed 12-Mega-
pixel CMOS sensor that produces superb image clarity. By employing H.265 compression tech-
nology and VIVOTEK’s Smart Stream Ill technology, the camera can reduce both bandwidth and
storage consumption by up to 80%* while retaining the highest standard of image quality.

Equipped with a fisheye lens for 180° panoramic view or 360° surround view (ceiling mount)
with zero blind spots, the cameras are able to provide coverage of wide, open areas, such as
airports, shopping malls, retail stores, offices and more.

The camera is equipped with a removable IR-cut filter and WDR Pro technology, empowering
the cameras to maintain optimal image quality around the clock and unparalleled visibility in
high-contrast lighting environments.

Revision History

Rev. 1.0: Initial release.
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Note that following with the use of batteries:

* Replacement of a battery with an incorrect type that can defeat a safeguard (for example, in the case
of some lithium batttery types)

» Disposal of a battery into fire or a hot oven, or mechanically crushing or cutting of a battery, that can
result in an explosion;

* Leaving a battery in an extremely high temperature surrounding environment that can result in an
explosion or the leakage of flammable liquid or gas;

* A battery subjected to extremely low air pressure that may result in an explosion or the leakage of
flammable liquid or gas.



Read Before Use

The use of surveillance devices may be prohibited by law in your country. The Network Camera is not
only a high-performance web-ready camera but can also be part of a flexible surveillance system. It is
the user’s responsibility to ensure that the operation of such devices is legal before installing this unit for
its intended use.

It is important to first verify that all contents received are complete according to the Package Contents
listed below. Take note of the warnings in the Quick Installation Guide before the Network Camera is
installed; then carefully read and follow the instructions in the Installation chapter to avoid damage due to
faulty assembly and installation. This also ensures the product is used properly as intended.

The Network Camera is a network device and its use should be straightforward for those who have basic
networking knowledge. It is designed for various applications including video sharing, general security/
surveillance, etc. The Configuration chapter suggests ways to best utilize the Network Camera and
ensure proper operations. For creative and professional developers, the URL Commands of the Network
Camera section serves as a helpful reference to customizing existing homepages or integrating with the
current web server.

Package Contents

m FE9391-EHV-v2 m RJ-45 penetration cap
m T10 anti-tamper screwdriver m Quick Installation Guide
m Waterproof seal plug m Desiccant bag

m Alignment sticker m Screw pack

Symbols and Statements in this Document

INFORMATION: provides important messages or advices that might help prevent inconvenient
or problem situations.

NOTE: Notices provide guidance or advices that are related to the functional integrity of the
machine.

%
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Tips: Tips are useful information that helps enhance or facilitae an installation, function, or
process.

WARNING: or IMPORTANT:: These statements indicate situations that can be dangerous or
hazardous to the machine or you.

Electrical Hazard: This statement appears when high voltage electrical hazards might occur
to an operator.

> B



/) NOTE:

Camera Hardware Preventative Maintenance:
1. Visual inspection of all major components including accessories, cabling and connections

where accessible for signs of deterioration or damage.

2. Check and clean cameras, lenses and housings inside and out as needed.

Please do not scratch, damage, or leave fingerprints on the dome/front cover and/or lens
because this may decrease image quality.

For general cleaning of dirty areas, it is suggested to use compressed air to remove dust
and/or other debris in order not to damage the on-board components.

In order to clean oil stains, it is recommended to use a spray-type decomposing cleaner
(absolutely avoid reciprocating wipes on the surface). After the oil has decomposed, spray
it with water, dry with air, and/or absorb water with a cotton cloth or a soft cloth (dab, please
avoid wiping).

Do not use harsh detergents, gasoline, benzene or acetone, etc. to clean as they may
deform or cause damage to the product. Also, excessive cleaning could damage the surface.

. Check images for correct field of view (pan, tilt and zoom focus) and adjust as necessary.

Check and replace the Micro SD memory card as needed.

Stop edge recording before removing the Micro SD memory card.

Make sure that the Micro SD memory card is right side up and do not insert it with force,
otherwise it may be damaged.

When it is raining or the humidity is high, insertion or ejection of the Micro SD memory card
is not recommended.

Disassembly of the dome/front cover carries the risk of internal dew condensation, so please
remember to replace the desiccant bags on the inside of the cameras before reassembly.
Check that the camera view has not been blocked by obstacles and that you can see the
property perimeter clearly.

Make sure the interiors of cameras and accessories, like mounting kits and/or enclosures,
are clean and dry.

Make sure cameras are securely attached to the wall/ceiling/mounting kits.

/\ IMPORTANT:

1. Please contact VIVOTEK's certified dealers for power adapters.

2. Installation and maintenance service should only be performed by qualified technicians.
3. If powered by a power adapter, the adapter should be properly grounded.

4. The power cord must be connected to a socket or outlet with a ground connection.



/\ IMPORTANT:

1. The product must be installed and protected in a location that is not easily accessible, and
is away from impacts or heavy vibration. For example, at the location where the surveillance
cameras are looking down or installed at high positions such as on a wall, or at least 3 meters
above the ground.

2. The camera should be installed at least 10 centimeters away from the eave of a building.and
will avoid direct exposure of the external wire to the sun and water environment.

. If powered by a power adapter, the adapter should be properly grounded.

. Maintenance and repair work must always be carried out by qualified technical personnel.
. Disconnect power from the unit when performing a maintenance task.

. Please contact VIVOTEK's certified dealers for power adapters.

(o206 I~ EV)

/\ IMPORTANT:

1. The camera is only to be connected to PoE networks without routing to outside plants.
2. For PoE connection, use only UL listed |.T.E. with PoE output.

1. La caméra ne doit étre raccordée qu’a des réseaux PoE, sans routage vers des installations
extérieures.

2. Pour les raccordements PoE, utilisez uniquement un équipement de TlI homologué UL, avec
une sortie PoE.

Use the camera only with a DC power supply that is UL listed, and limited power source (LPS)
certified. The power supply should bear the UL listed and LPS marks. The power supply should
also meet any safety and compliance requirements for the country of use.

n'utilisez la caméra qu’avec un bloc d’alimentation CC homologué UL, ainsi qu’avec
une alimentation limitée (LPS) certifiée. Le bloc d’alimentation doit porter les indications
d'homologation UL et LPS. Il doit également répondre aux exigences en matiére de sécurité et
de conformité relatives au pays d’utilisation.



/\ IMPORTANT:

For some customers who already have their own web site or web control application, the
Network Camera/Video Server can be easily integrated through URL syntax. This section
specifies the external HTTP-based application programming interface. The HTTP-based camera
interface provides the functionality to request a single image, control camera functions (PTZ,
output relay etc.), and get and set internal parameter values. The image and CGl-requests are
handled by the built-in Web server.

+ To send URL commands in the address bar of your web browser, please remember to
disable the Cross-Site Request Forgery (CSRF) protection in Configuration > Security >
Miscellaneous.

Y viverx

Home Client settings JeLIGTEICL Language
Security > Miscellaneous

Miscellaneous

[] Enable Cross-Site Request Fargery(CSRF) protection.

We strongly recommend not to disable this protection. Disabling this feature will expose your
camera to risks.

o [ sae ]

HTTPS

Access list

IEEE 802.1x

Miscellaneous
PTZ
Event
Applications
Recording

Storage

» For up-to-date documentation of URL commands, please go to VIVOTEK’s website, register
an account with a business mail address and submit for authorization for SDK in Support >
Downloads > SDK.

gVIV@EK Products  Solutions Partners Support About Us Investor Relations Where 1o Buy

Cybersecurity Downloads
Support + Cerfificate * Brochure
« ALE * Flyer
Learning * Product Files + Successful Cases
TOOL * Frmware = Video Library
« Software * Webinar
Legacy Products s SDK = White Paper
Cybersecurity Corporate
* Hardening Guide * VI Guidelines

* Green Certification

* logo

» For any further technical support, please contact our technical support department.



Hardware Reset

The reset button is used to reset the system or restore the factory default settings. Sometimes
resetting the system can return the camera to normal operation. If the system problems remain
after reset, press the reset button longer to restore the factory settings and install again.

Reset: Press and release the recessed reset button with a straightened paper clip. Wait for the
Network Camera to reboot.

Restore: Press and hold the recessed reset button for at least several seconds to restore. Note
that all settings will be restored to factory defaults.

Micro SD/SDHC/SDXC Card Capacity

This network camera is compliant with SD/SDHC/SDXC 16GB / 8GB / 32GB / 64GB / , and up
to 512/ 1024GB and other preceding standard SD cards.



Physical Description

Inner View

RJ45 Ethernet port

Through hole for /O combo ¥
Through hole for Ethernet

Contacts pins for IR LEDs

» Status LEDs

MicroSD/SDHC/SDXC Card Slot
Reset Button



LED Definition

Iltem LED Status Description

1 Steady Red Power on and system booting
Red LED off Powered off

2 Steady Red + blinking Green every 1 sec. (Green|Network heartbeat

LED on for 1 sec and off for another)
Steady Red + Green LED off Network disconnected
3 Blinking Red every 0.15 sec. + Blinking Green|Upgrading firmware
every 1 sec. (Red LED on for 0.15 sec. and Green
LED on for 1 sec. and off for another)

4 Blinking Red every 0.15 sec. + blinking Green|Restoring defaults
every 0.15 sec

PoE 37-57V, 0.57-0.37A 21W (PoE mid-span or switch)
DC: 12V, 1.75A, 21W

Max. 22.5W(IR ON)

Max. 9.5W(IR OFF)

g Consumption & Power Input




Hardware Installation

1. Jot down the camera’s MAC address for later reference.

( )

Network Camera XVIV@'EK

- XXXXXX E 0

MAC: 0002D1083236 XXXXX

E\/ RoHS

—_—
This device complies with part 15 of the FCC Rules. Operation is subject to
the following two conditions:
(1) this device may not cause harmful interference, and
(2) this device must accept any interference received, including interference
that may cause undesired operation

L Pat. 6,930,709 Made in Taiwan )

2.Remove the top cover by loosening the T10 anti-tamper screws.

o It is recommended to use an Eth-
-@- ernet cable without the protective
sleeve.

B




3.Install an SD card is onboad storage is preferred.

4. Use the alignment sticker to drill holes at the location you prefer. Drill another routing hole for
the cables.




1S

5. Sepate the camera from the base plate by snatching and splitting it near the snap-in tab.




7. Remove the silicone seal from the hole.

8. Remove the tip of the silicone seal by pulling it off. Insert the RJ45 connector of your Ethernet
cable into the penetration cap.




9. Push the penetration cap through the center of the silicone seal.

If grommets are
damaged, replace them
with new ones.

10. Install the silicone seal to its original routing hole.




11. Connect the Ethernet connector and secure the top of the silicone seal to the routing hole.
You may need to adjust its position.

ST
st

12. Pull the cable slightly backward. Please do not leave the edge of center hole folded toward
the inside of the camera. Doing so will compromise its waterproof feature.




13. If you purchased a DI/DO combo cable for the camera, pass the white pin headers through
the cabling hole. Using a crescent wrench, tighten a hex nut and washer to waterproof the
combo cable. Connect these headers to the connectors on camera.

14.
1. Stretch the waterproof tape by twice its length and

wind around the cables.

2. The tape should overlap the cable joints by 20mm.
3. All connectors, whether they are used or not,
should be waterproof.

( Cable molding ;
¥

Layer - Self-fusing tape
or electric tape




VIVOTEK

15. Connect a ground wire to the bottom of the camera. Note the details in the drawing below.

18 AWG min.
3.5mm screw mm.
Green & Yellow wires

®

Crimping plier

* Use knurled washers

16.

Please replace the desiccant bag
with a new one.

User's Manual - 19



17. Secure the camera to the base plate by aligning the snap-in tabs. Press until the snap-in tab-
sare firmly in place.

&=
R

‘\§._: i ‘:\;: -‘
(L
e
— | _E%"gil;a

X
—

plate.




19. Secure the dome cover by fastening the T10 anti-tamper screws..

A R

T10

20. Remove the protective sheet from the dome cover.




21. Install the “Shepherd” software utility from VIVOTEK’s website.

The program will search for VIVOTEK Video Receivers, Video Servers or Network Cameras
on the same LAN.

Double-click on the camera’s MAC address to open a browser management session to the
camera.

Shepherd




Software Installation

22. Install the Shepherd utility, which helps you locate and configure your Network Camera in
the local network. If your camera comes without the CD, go to VIVOTEK’s website, and locate
the utility in the Downloads > Software page.

%/VIV@EK Products Support Downloads Solutions  Le¢

3. Product Files
Brochure
Firmware
Flyer

Logo

Software I

Wall Paper

for Toug® |

22-1. Run the Shepherd utility.

22-2. The program will conduct an analysis of your network environment.




22-3. The program will search for all VIVOTEK network devices on the same LAN.

22-4. After a brief search, the installer window will prompt. Click on the MAC and model name
that matches the one printed on the product label. You can then double-click on the address
to open a management session to the Network Camera.

1 selected @

hiPrange |

MAC:0002D1730202 RoHsc € w1360

00O I FC

All devices Selected
irmware




VIVOTEK

Forceful Password Configuration

23. The first time you log in to the camera, the firmware will prompt for a password configuration
for security concerns.

23-1. Since your camera is used for the first time, there is no password. Enter “root” as the user
name, and nothting for the password.

The server 169.254.205.239 is asking for your user name and
password. The server reports that it is from streaming_server.

Warning: Your user name and password will be sent using basic
authentication on a connection that isn’ t secure.

’ root

|

Remember my credentials

(&= J[ =& |

23-2. Enter the combination of alphabetic and numeric characters to fulfill the password strength
requirement. The default name for the camera administrator is “root”, and can not be
changed.

% viver=k

-
Www.viveTEx.com

Language

Configure password

Password should meet the following requirements:
*8~64 characters with no spaces
*include at least one alphabetic character
*include at least one numeric character

User name : root
User password : I"""”” | - Medium
Confirm user password : |"""”n |

[[] Enable HTTPS secure connection

*The new password will be applied to all connections

Next Cancel I

User's Manual - 25




VIVOTEK

Some, but not all special ASCII characters are supported: !, $, %, -, ., @, », _, and ~.
You can use them in the password combination.

You have used invalid characters. These characters are valid:A-Z,
a-z, -9 and 15%-.@~_~

23-3. Another prompt will request for the password you just configured. Enter the password and
then you can start configure your camera and see the live view.

The server 169.254.203.238 is asking for your user name and
password. The server reports that it is from streaming_server.

VWarning: Your user name and password will be sent using basic
authentication on a connection that isn’ t secure.

ot |

eseccccsccccee |
Remember my credentials

L= || =& |

26 - User's Manual




VIVOTEK

Cybersecurity

Once you open the web console, enter Configuration > Applications > Package
management, and click on Trend Micro loT Security. Turn on the protection to fend off cyber
attacks.

In here, you can let the camera automatically update the virus codes or manually update the
virus codes.

Y vivers
uuuuuuuuuuu = ! Home Client settings oI LENELGLE Language
Applications > Package management
System Package | | License
Media — Upload 1
Network Selectfile | [ 25 |[ upload |
Security — R status
CPU loading: 2%
PTZ
Internal siorage total size: 1951.828 MB Free size: 1803.769 MB
[Eremt Memory total size: 1926105 MB Freesize:  1213.089 MB
Applications
Motion detection  Clean 9
Smart VCA Motice! It will erase system temporary files and the files upload from FTP. |
Di and DO
Tampering detection
Audio detection — Package list
Shock detection Name Version Status  License size W[
() Trend Micro loT Security 13eal.81 Installed  N/A 6246MB O 10
Package management
O Deep Learning VCA 6.6.4.0-3e ON NiA 17.039MB o0 I0
Recoeding O Stratocast 1.3eal5.0 ON NiA 3066 MB o0 T
Storage
][ Schedule

Cybersecurity

Trend Micro loT Security On/Off @) ~
Signature update
Current Version: 1.028
Auto Update ‘)
Manual Update:
Select Signature File : | | m=_ || Upgrade
Event Tigger for 3rd party Software
Brute force attack ()
Cyber attack D
Quarantine event [ @)
License Expiration event @)
Attack Block Summary
. . v
Since 2020/05/05, block total O hits
@Copyright VIVOTEK Inc @ TREND.

User's Manual - 27




VIVOTEK

v~ The mounting holes on the base plate can accommodate the mounting positions on
@ different electrical boxes. See below for their related positions.

Cantex 3/4” type FSE 2 Gang, Outdoor/Indoor electrical box
Generic 3/4” conduit box enclosure, 3/5 holes

28 - User's Manual




Network Deployment

Setting up the Network Camera over the Internet

There are several ways to set up the Network Camera over the Internet. The first way is to set
up the Network Camera behind a router. The second way is to utilize a static IP. The third way is
to use PPPoE.

Internet connection via a router

Before enabling the access to the Network Camera over the Internet, make sure you have a
router and follow the steps below.

1. Connect your Network Camera behind a router, the Internet environment is illustrated below.

Regarding how to obtain your IP address, please refer to Software Installation on page 23 for
details.

< ” &/
WAN (Wide Area Network ) / IP address : 192.168.0.3

Router IP address : from ISP Subnet mask : 255.255.255.0
Default router : 192.168.0.1

Internet

LAN (Local Area Network)
Router IP address : 192.168.0.1

Cable or DSL Modem \

IP address : 192.168.0.2
Subnet mask : 255.255.255.0
Default router : 192.168.0.1

2. In this case, if the Local Area Network (LAN) IP address of your Network Camera is
192.168.0.3, please forward the following ports for the Network Camera on the router.
m Secondary HTTP port: 8080
m RTSP port: 554
m RTP port for audio: 5558
m RTCP port for audio: 5559
m RTP port for video: 5556
m RTCP port for video: 5557
If you have changed the port numbers on the Network page, please open the ports
accordingly on your router. For information on how to forward ports on the router, please refer
to your router’s user’s manual.

3. Find out the public IP address of your router provided by your ISP (Internet Service Provider).
Use the public IP and the secondary HTTP port to access the Network Camera from the
Internet. Please refer to Network Type on page 93 for details.



For example, your router and IP settings may look like this:

Device IP Address: internal  |IP Address: External Port (Mapped port on the
port router)

Public IP of router [122.146.57.120
LAN IP of router 192.168.2.1
Camera 1 192.168.2.10:80 122.146.57.120:8000
Camera 2 192.168.2.11:80 122.146.57.120:8001

Configure the router, virtual server or firewall, so that the router can forward any data coming
into a preconfigured port number to a network camera on the private network, and allow data
from the camera to be transmitted to the outside of the network over the same path.

From Forward to
122.146.57.120:8000 (192.168.2.10:80
122.146.57.120:8001 [192.168.2.11:80

When properly configured, you can access a camera behind the router using the HTTP request
as follows: http://122.146.57.120:8000

If you change the port numbers on the Network configuration page, please open the ports ac-
cordingly on your router. For example, you can open a management session with your router to
configure access through the router to the camera within your local network. Please consult your
network administrator for router configuration if you have troubles with the configuration.

For more information with network configuration options (such as that of streaming ports),
please refer to Configuration > Network Settings. VIVOTEK also provides the automatic port for-
warding feature as an NAT traversal function with the precondition that your router must support
the UPNP port forwarding feature.

Heebwrork Type Fort

= AN

& Gat P address. autormaticaly

General settings Use fxad P pddress

SIrEamang profosoia ¥ Enable UPeP prepenistion

D0 5 +| Enabie UPsP pom fanwarding l
Qs PPRSE

SHMP ¥ Enatle PvG

The device & configurng now . ioer browser will reconnect
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B the conndcton fnis, please manualy enler e sbove P
SANESE N o Brgwaer ——

— | S

Wanusky




Internet connection with static IP

Choose this connection type if you are required to use a static IP for the Network Camera.
Please refer to LAN configuration on page 93 for details.

Internet connection via PPPoE (Point-to-Point over Ethernet

Choose this connection type if you are connected to the Internet via a DSL Line. Please refer to
PPPoE on page 115 for details.

Set up the Network Camera through Power over Ethernet (PoE)

When using a PoE-enabled switch
The Network Camera is PoE-compliant, allowing transmission of power and data via a single

Ethernet cable. Follow the below illustration to connect the Network Camera to a PoE-enabled
switch via an Ethernet cable.
ﬁ NOTE:

1. The camera is only to be connected to PoE networks
without routing to outside plants.

2. For PoE connection, use only UL listed I.T.E. with PoE
output.

m

Power + Data Transmission PoE Switch

When using a non-PoE switch

If your switch/router does not support PoE, use a PoE power injector (optional) to connect
between the Network Camera and a non-PoE switch.

PoE Power Injector
(optional)

Non-PoE Switch



NOTE:

1. If you encounter problems with displaying live view or the onscreen plug-in control, you may try
to remove the plug-ins that might have been installed on your computer. Remove the following
folder: C:\Program Files (x86)\Camera Stream Controller\.

2. If you forget the root (administrator) password for the camera, you can restore the camera
defaults by pressing the reset button for longer than 5 seconds.

3. If DHCP is enabled in your network, and the camera cannot be accessed, run the IW2 or
Shepherd utility to search the network. If the camera has been configured with fixed IP that
does not comply with your local network, you may see its default IP 169.254.x.x. If you still
cannot find the camera, you can restore the camera to its factory defaults.

4. If you change your network parameters, e.g., added a connection to a LAN card, re-start the
IW2 or Shepherd utility.



Accessing the Network Camera

This chapter explains how to access the Network Camera through web browsers, RTSP players,
3GPP-compatible mobile devices, and VIVOTEK recording software.

Using Web Browsers

A IMPORTANT:

Currently the Network Camera utilizes 32-bit ActiveX plugin. You CAN NOT open a
management/view session to the camera using a 64-bit IE browser.

If you encounter this problem, try execute the lexplore.exe program from C:\Windows\
SysWOW64. A 32-bit version of IE browser will be installed.

On Windows 7, the 32-bit explorer browser can be accessed from here: C:\Program Files
(x86)\Internet Explorer\iexplore.exe

Use Installation Wizard 2 (IW2) to access the Network Cameras on the LAN.

If your network environment is not a LAN, follow these steps to access the Netwotk Camera:

1. Launch your web browser (e.g., Microsoft® Internet Explorer, Mozilla Firefox, or Netscape).

2. Enter the IP address of the Network Camera in the address field. Press Enter.

3. The live video will be displayed in your web browser.

4. If it is the first time installing the VIVOTEK network camera, an information bar will prompt as
shown below. Follow the instructions to install the required plug-in on your computer.

3 4 2 - [5/x|
o
€) [ [B) @b POsewch §crovortes @ NP 3
&) oz, 16551511 v8
©) Thisse might requie the Folwing ActiveX cantrol: RTSP MPEG# 5P Control from VIVOTEK INC.", Clek here to nstall... x
gW@EK Mega-Pixel Network Camera
VDT v This is a plug-in (ActiveX). If you see this text, your browser is not support or disable ActiveX.
Display mods 1+ =
Y — [o/(2ln(e][o] s (x| ®) (t ¥] =
ot
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-‘@’- Tips:

1. The onscreen Java control can malfunction under the following situations: A PC connects to
different cameras that are using the same IP address (or the same camera running different
firmware versions). Removing your browser cookies will solve this problem.

2. If you encounter problems with displaying the configuration menus or Ul items, try disable

the Compatibility View on IE8 or IE9.

)t o porsmsncom - [Bo x]

You may also press the F12 key to open the developer tools utility, and then change the
Browser Mode to the genuine IE8 or IE9 mode.

228 Document Mode: IE9 standards

File Find Disable View Images Cache Tools Walidate | Brows
HTML | CS5 Console Script Profiler Metwork Internet Explorer 7 £
L\g = | & = Internet Explorer &

p~<IDOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.8~
B-<html xmlns="http:// www. F1998 fxhtml™ >

v Internet Explorer @ S
Internet Explorer @ Compatibility View

* In the event of plug-in compatibility issues, you may try to uninstall the plug-in that was previ-
ously installed.

. Business Explorer

. Camera Stream Controller
J# Uninstall

| Catalyst Control Center -

34 - User's Manual




NOTE:

1. By default, your Network Camera is not password-protected. To prevent unauthorized access,
it is highly recommended to configure a password for your camera later. For more information
about how to enable password protection, please refer to Security on page 112.

2. If you see a dialogue box indicating that your security settings prohibit running ActiveX
Controls®, please enable ActiveX Controls for your browser.

To enable the ActiveX® Controls for your browser:

2-1. Choose Tools > Internet Options >

Security > Custom Level.

General | Secunty | Privacy | Content | Connections | Programs | Advanced
Select a'web content zone to specify itz security settings.
2 0 @
Local intranet  Trugted sites  Restricted
sites

Internet

Thiz zone containg all ‘wWeb sites you
haven't placed in ather zones

Security level for this zone

Custom
Cusztom settings.
- To change the settings, click Custam Level.
- To uge the recommended settings, click Default Level.

[ Cusztomn Level... ] Default Lewvel ]

[ 0K H Cancel ]

2-2. Look for Download signed ActiveX® _
controls; select Enable or Prompt. Click OK. Security Settings 3

Setkings:

controls and plug-ins A
E] Download signed Activel controls
() Disable
II:_:ZI Enable
(@) Prompk
|¥] Download unsigned Activex controls
() Disable
(®) Enable
{_) Prompt
g Initizlize and script Activey controls not marked as safe
(") Disable
(®) Enable

) Prompt
l n__ Aakiiiabl! cemboele cmd ol e b
< >
Reset custom settings
Reset to: | Medium v

[ 4 ][ Cancel l

2-3. Refresh your web browser, then install the ActiveX® control. Follow the instructions to
complete installation.



Using RTSP Players

To view the streaming media using RTSP players, you can use one of the following players that
support RTSP streaming.

&2 VLC media player

1. Launch the RTSP player.

2. Choose File > Open URL. A URL dialog box will pop up.

3. The address format is rtsp://<ip address>:<rtsp port>/<RTSP streaming access name for
stream1 or stream2>

As most ISPs and players only allow RTSP streaming through port number 554, please set the
RTSP port to 554. For more information, please refer to RTSP Streaming on page 100.
For example:

- A Open Media -
Playlist P File  @Disc % Network  [ZF Capture Device
Playlist Network Protocol
Media Librar Please enter a network URL;
My Computer [rts0://192. 168.51.64:5° 4/1i )
My Videos | S

4. The live video will be displayed in ybur plé‘yéf.k
For more information on how to configure the RTSP access name, please refer to RTSP
Streaming on page 100 for details.

A rtsp://192.168.51.145:554/lives1.sdp - VLC media player - o x
Media Playback Audio Video Subtitle Tools View Help

= LR A - N,
00:25 00:00
[ Mo lhF il 2

(IR IR RER=1F o




Using 3GPP-compatible Mobile Devices

To view the streaming media through 3GPP-compatible mobile devices, make sure the Network
Camera can be accessed over the Internet. For more information on how to set up the Network
Camera over the Internet, please refer to Setup the Network Camera over the Internet on page

29.
To utilize this feature, please check the following settings on your Network Camera:

1. Because most players on 3GPP mobile phones do not support RTSP authentication, make
sure the authentication mode of RTSP streaming is set to disable.
For more information, please refer to RTSP Streaming on page100.

2. As the the bandwidth on 3G networks is limited, you will not be able to use a large video size.
Please set the video and audio streaming parameters as listed below.
For more information, please refer to Stream settings on page 80.

Video Mode MPEG-4
Frame size 176 x 144
Maximum frame rate 5 fps
Intra frame period 1S

Video quality (Constant bit rate) 40kbps
Audio type (GSM-AMR) 12.2kbps

3. As most ISPs and players only allow RTSP streaming through port number 554, please set
the RTSP port to 554. For more information, please refer to RTSP Streaming on page 100.

4. Launch the player on the 3GPP-compatible mobile devices (e.g., Real Player).

5. Type the following URL commands in the URL field.
The address format is rtsp://<public ip address of your camera>:<rtsp port>/<RTSP streaming

access name for stream 3>.
For example:

& Open Media - X

Playlist D File @) Disc %% Network = Capture Device
Playlist Network Protocol
1l Media Library Please enter a network URL:

My Computer frisp://192.168.51.64:554/livels1sr}
My Videos

My Music
[&Z] My Pictures
Devices

@ Discs

| P

] Show more options

Play |» Cancel

> - o L]

You can configure Stream #2 into the suggested stream settings as listed above for live
viewing on a mobile device.



Using VIVOTEK Recording Software

Visit our website for download the VAST recording software that provides simultaneous
monitoring and video recording for multiple Network Cameras. Please install the recording
software; then launch the program to add the Network Camera to the Channel list. For detailed
information about how to use the recording software, please refer to the user’s manual of the
software or download it from http://www.vivotek.com.

WV vasT

FE8180
1920x1920
H264

1. If you encounter problems with displaying live view or the onscreen plug-in control, you may try
to remove the plug-ins that might have been installed on your computer. Remove the following
folder: C:\Program Files (x86)\Camera Stream Controller\.

2. If you forget the root (administrator) password for the camera, you can restore the camera
defaults by pressing the reset button for longer than 5 seconds.

3. If DHCP is enabled in your network, and the camera cannot be accessed, run the Shepherd
utility to search the network. If the camera has been configured with fixed IP that does not
comply with your local network, you may see its default IP 169.254.x.x. If you still cannot find
the camera, you can restore the camera to its factory defaults.

4. If you change your network parameters, e.g., added a connection to a LAN card, re-start the
Shepherd utility.


http://www.vivotek.com

Main Page

This chapter explains the screen elements on the main page. It is composed of the following
sections: VIVOTEK INC. Logo, Host Name, Camera Control Area, Configuration Area, and Live
Video Window.

VIVOTEK logo Resize Buttons Configuration
Area

Host name <——— re9301-env-v2

]
- | § [ e

- — N\ /B £
NAVPA

e VA

Camera Control

Panel e = > SRT——
Live View window & =1

VIVOTEK INC. Logo
Click this logo to visit the VIVOTEK website.

Host Name
The host name can be customized to fit your needs. For more information, please refer to System > General
Settings on page 53.

Camera Control Area

Display mode: This is a brand new configuration menu exclusively designed for Fisheye cameras. Due
to the fisheye lens’ wide coverage of 180° hemispheric and 360° panoramic views and to manipulate the
details within, the following display modes are provided:

Display mode 10 - One Original fjshgye view.
Profile name: | % 1P - One Pancl)ramlc'wew
2P 1R - One Regional view
# Manual triggq 105R 1P2R - One Panoramic and two Regional views (Wall mount)
Digital output: | 4g pro | 2P - Two Panoramic views
PTZ control: [ 1O%R 1P3R - One Panoramic and three Regional views (Wall mount)
[_ 103R - One Original and three Regional views

4R - Four Regional views

4R PRO - Four Regional views interactively displayed when the field
of view changes in any of the views

108R - One Original and eight Regional views

* Most display modes are available in the Ceiling mount type.
* See following discussions for detailed explanation of these modes. If
selected, the Wall mount type provides another two distinctive modes.



1 riginal) Display m : . . . .
© (Original) Display mode 10 View (Original View)

When mounted on a ceiling, the fisheye camera can

cover an approximate of 64 m? surveillance area (installed @

at a height of approximately 3 meters), while still keeping

details in videos with recognizable facial features of

people trafficking through the area.

180° Hemispheric

The 10 view is especially adequate for taking an over-
view glimpse of the surveillance area when mounted on the
ceiling.

1P (Single Panoramic) Display mode:

With image correction algorithms in firmware, the hemispheric image is transformed into a rectilinear
stripe in the 1P display mode. Viewers can use the PTZ panel or simply use mouse swipe to quickly
move through the 360° panoramic view. (Mouse control on the Panoramic view is available with the

Ceiling mount type.)

When mounted on a wall, this mode can cover a 180° overview from side to side, e.g., on the entrance of
a building or a corridor.

Note that the 1P view is apt for an overview, the Zoom in/out function does not apply in this mode.

0 Live View

| Mega-Pixel Network Camera

~ Swipe to scroll horizontally

= e e Lo e S e — TR



1R (Single Regional) Display mode:

The 1R mode provides access to one image section within the hemisphere. You can zoom in or out
(using the mouse wheel or PTZ panel) or travel to other areas in the hemisphere using mouse clicks and
swipes. A single click on a particular object can bring the object to the center of your view window. Click
and hold down the left mouse button, and you can swipe the view in all directions.

1R View (Single Regional View)

Zoom in/out
&
all-directional
navigation control

2P (Dual Panoramic View) Display mode:

Similar to 1P, the 2P display mode provides simultaneous access to both the left and right sections of a
hemisphere. Both panoramic views are corrected into a more viewable dewarped image. Viewers can
use a mouse click and swipe to quickly scroll horizontally through the surveillance area.

* Note that the dividing line falls approximately on the center of the VIVOTEK logo on camera.

2P View (Panoramic View) Converted to rectilinear view (Dewarp)

@ Left hemi Right hemi 3 2]

[




103R (One Original & Three Regional) Display mode:

The 103R mode provides access to multiple live view sections within the hemisphere and the reference
to their relative positions on an Original circular view. The FOV indicators (#1 ~ #3) interact with your
current operation as you may zoom in/out or move the live view window to a different place.

You can zoom in or out or travel to other areas within the hemisphere using identical methods as
previously described in the 1R mode.

You can also change the locations of Regional views by dragging the FOV indicators on the "Original"
circular view.

103R (Original & Regional) Mode Screen Control

%/VIV;@'IEK“ Mega-Pixel Network Camera
Display mode [103R |v] T Client settings | Configuration | Language

Profile name: Mal. Fis
# Manual triggers:

Digital output

— |nteractive
regional FOV indicators

Pan speed:
Tilt speed:
Zoom speed:

Panoramic speed-[1 [v] —+— Current screen selection

ck to bring into '
center of view

9

@ \E\E\@@@ Goto —Selectone— -

3'— Tips:
In a Regional view displaying 100% of video feed (via the Resize buttons - see page 46), your

mouse wheel can be used to scroll the view window vertically before you click on a live image.
After you click on the live image, the mouse wheel becomes the zoom in/out tool.



VIVOTEK

When you select a regional view, its relative position in the FOV will be indicated by a semi-transparent
color polygon on the the circular original view. When you move your regional view, the color polygon
moves accordingly.

= EE R e TSI Glient settings | Configuration | Language

2000/1/1 02:55:43

aln](e][o][s] xR [¥c
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4R (Four Regional) Display mode:

The view control and look and feel are identical to that as described in the 103R mode except that the
Original circular view is absent from this mode.

4R PRO (Four Regional Proactive) Display mode:
The 4R PRO mode is similar to the 4R mode except that the quad view windows consecutively rotate in

correspondence to the change of view area in one window. Note that zoom in/out and tilt control is not
available in this mode.

108R (One Original and Eight Regional) Display mode:
The view control and look and feel are identical to that as described in the 103R mode.
Note that if you change the position of a view in hemisphere, e.g., #3 window, you may lose the

configuration change by switching to another display mode. The live view window does not automatically
save your view section layout.

Y viverk
Display mode m

TN client settings | Configuration | Language
Profile name:  [Max[ v

20151113 09:41:24

& Manual triggers:

Digital output: 3 2 1

(=] Zoom [+]
Pan speed: o 1+
Tilt speed: m

Zoom speed: 0 |v| 4
Panoramic speed:[1 |~

B
=]
o
e]
]
Ll
™
|
k=l
]




Profile mode: 3 pre-configured streaming profiles are provided through here: Max. view, Recording
view, Live view. Each mode features a different stream source (channel), resolution, multicast, and
metadata configuration.

The profiles can be configured in Configuration > Media > Media profiles.

Manual Trigger: Click to manually enable or disable an event trigger. Please configure an event setting
before enabling this function. A total of 3 or 4 event settings can be configured. For more information
about event setting, please refer to page 130. If you want to hide this item on the homepage, please go
to the System > Homepage Layout > General settings > Customized button to deselect the “show
manual trigger button” checkbox.

Digital OQutput: Click to turn the digital output device on or off.

PTZ Control Panel:

Up
Return to Home Position
u .
Left - ™ B Right
Down [
Zoom Out Lo s [ 41— Zoomn
Start the Panoramic [FPane | skp |Ratate]  Rotate

rotation

Stop Auto Pano or Rotate

Pano.: Click this button to start the automatic horizontal pan (360° continuous rotation).

Stop: Click this button to stop the Auto Pano and Auto Rotate functions.

Rotate: Once the Administrator has configured the list of preset positions (including the zoom-in action
on a particular position), click this button to command the camera to display the preset positions in a
consecutive order. The Network Camera will display those positions continuously. For more information,
please refer to PTZ control on page 127.

Se\ectstream.

A Pan speed
| - | Home | » | Tilt speed
v Zoom speed
I:l P II' Panoramic speed
Preset and rotate settings
Name:| Add preset location Rotate speed 1 |
User preset locations Rotate locations
& v
1 il 1 n
2 2
3 2
4 4

M s v s

W
[omow [4]7]



Pan /Tilt /ZZoom speed: Adjust the speed of these controls when exerted:

Pan speed

Configuration Area

Client Settings: Click this button to access the client setting page. For more information, please refer to
Client Settings on page 50.

Tilt speed

Zoom speed

Panoramic
speed

a B~ WON =~ O

Slower

Faster

Configuration: Click this button to access more of the configuration options provided with the Network
Camera. It is suggested that a password is applied to the Network Camera so that only the administrator
can configure the Network Camera. For more information, please refer to the description for the
Configuration menus on page 52.

Language: Click this button to choose a language for the user interface. Language options are available
in: English, Deutsch, Espafiol, Frangais, Italiano, P # 3, Portugués, f§ +* <, and %% * < You can
also change a language on the Configuration page; please refer to page 52.

Hide Button
You can click the hide button to hide the control panel or display the control panel.

Resize Buttons

EH St

B 1004

Ed S0%

EH 25% | .

Click the Auto button, the video cell will resize automatically to fit the monitor.
Click 100% is to display the original homepage size.
Click 50% is to resize the homepage to 50% of its original size.
Click 25% is to resize the homepage to 25% of its original size.



m The following window is displayed when the video mode is set to MJPEG:

Video Title deo P 015/03/10 17:08:56 (e BT =)
Title and Time deo 17:08:56 2015/03/10 |2 ,

e “ )
B g
4 4 ;7’* /ri" iy
4 2 ZT/J :
-¥"‘ puY
- \
) R
\\ . 4 - (7 %
A\ a 5E
2 \ s @ &

@ \E\ Goto —Selectone— = : Video Control Buttons

Video Title: The video title can be configured. For more information, please refer to Media > Image on
page 66.

Time: Display the current time. For more information, please refer to Media > Image on page 66.

Title and Time: Video title and time can be stamped on the streaming video. For more information, please
refer to Media > Image on page 66.

2.0x Title 2020/03/05 10:39:08

Video Control Buttons: Depending on the camera model and your current configuration, some buttons
may not be available.

E Snapshot: Click this button to capture and save still images. The captured images will be displayed
in a pop-up window. Right-click the image and choose Save Picture As to save it in JPEG (*.jpg) or BMP
(*.bmp) format.

F Start MP4 Recording: Click this button to record video clips in MP4 file format to your computer.
Press the El Stop MP4 Recording button to end recording. When you exit the web browser, video
recording stops accordingly. To specify the storage destination and file name, please refer to MP4 Saving
Options on page 51 for details.

ﬁ Full Screen: Click this button to switch to full screen mode. Press the “Esc” key to switch back to normal
mode.

Please refer to page 127 for PTZ settings.



Live Video Window
m The following window is displayed when the video mode is set to H.265 or H.264:

H.264/MPEG-4 Protocol and Media Options )
Time

. Video T|tle (Videol(TPC-AV) | Video 13:59:05 2012/07/04

Title and Time [Video 13:59:05 2012/07/04 EEZAE

FOOOEEDPTE T
|—. Video and Audio Control Buttons

Video Title: The video title can be configured. For more information, please refer to Video settings on
page 80.

H.264 Protocol and Media Options: The transmission protocol (TCP or UDP, etc.)and media options for
H.265 or H.264 video streaming. For further configuration, please refer to Client Settings on page 50.

Time: Display the current time. For further configuration, please refer to Media > Image > Genral settings
on page 66.

Title and Time: The video title and time can be stamped on the streaming video. For further configuration,
please refer to Media > Image > Genral settings on page 66.

Video and Audio Control Buttons: Depending on the Network Camera model and Network Camera
configuration, some buttons may not be available.

@ Snapshot: Click this button to capture and save still images. The captured images will be displayed
in a pop-up window. Right-click the image and choose Save Picture As to save it in JPEG (*.jpg) or BMP

(*.omp) format.

@ Pause: Pause the transmission of the streaming media. The button becomes the E Resume button
after clicking the Pause button.

@ Stop: Stop the transmission of the streaming media. Click the E Resume button to continue
transmission.



B Start MP4 Recording: Click this button to record video clips in MP4 file format to your computer.
Press the @ Stop MP4 Recording button to end recording. When you exit the web browser, video
recording stops accordingly. To specify the storage destination and file name, please refer to MP4 Saving
Options on page 51 for details.

@ Volume: When the Mute function is not activated, move the slider bar to adjust the volume on the
local computer.

Mute: Turn off the volume on the local computer. The button becomes the Audio On button after
clicking the Mute button.

Mic Volume: When the @ Mute function is not activated, move the slider bar to adjust the
microphone volume on the local computer.

Full Screen: Click this button to switch to full screen mode. Press the “Esc” key to switch back to normal
mode.

fVIV@‘EK FE9391-EHV-v2
Display mode

=1 [BCTSTEM Client settings | Configuration | Language
Profile name:  [Mex~] s21ors 102527

# Manual triggers:
Digital ou o

PTZcontrol:  [Digital v




Client Settings

This chapter explains how to select the stream transmission mode and saving options on the
local computer. When completed with the settings on this page, click Save on the page bottom
to enable the settings.

H.265 / H.264 Protocol Options

Select to stream video or audio data or both. This is enabled only when the video mode is set to H.265 or
H.264.

H.265/H.264 protocol options

TCP v

H.265 / H.264 Protocol Options

UDF Unicast itions
LDP Multicast

HTTP

Depending on your network environment, there are four options with the transmission protocols with the
H.265 or H.264 streaming:

UDP unicast: This protocol allows for more real-time audio and video streams. However, network
packets may be lost due to network burst traffic and images may be broken. Activate UDP connection
when occasions require time-sensitive responses and the video quality is less important. Note that each
unicast client connecting to the server takes up additional bandwidth and the Network Camera allows up
to ten simultaneous accesses.

UDP multicast: This protocol allows multicast-enabled routers to forward network packets to all clients
requesting streaming media. This helps to reduce the network transmission load of the Network Camera
while serving multiple clients at the same time. Note that to utilize this feature, the Network Camera must
be configured to enable multicast streaming at the same time. For more information, please refer to
RTSP Streaming on page 100.

TCP: This protocol guarantees the complete delivery of streaming data and thus provides better video
quality. The downside of this protocol is that its real-time effect is not as good as that of using the UDP
protocol.

HTTP: This protocol allows the same quality as TCP protocol without needing to open specific ports for
streaming under some network environments. Users behind a firewall can utilize this protocol to allow
camera’s streaming data to pass through.



MP4 Saving Options

MP4 saving options

Folder: D:\Record3 Browse...

File name prefi. CLIP

Add date and time suffix to file name

Users can record live video as they are watching it by clicking the lT “Start MP4 Recording” button on
the main page. Here, you can specify the storage destination and file name.

Folder: Specify a storage destination for the recorded video files.

File name prefix: Enter the text that will be appended to the front of the video file name.

Add date and time suffix to the file name: Select this option to append the date and time to the end of the
file name.

( )
CLIP_20200328-180853

tt

File name prefix Date and time suffix
The formatis: YYYYMMDD_HHMMSS

Local streaming buffer time

Local Streaming Buffer Time

0 Millisecond

Csae |

Due to possible occurrences of unsteady network transmission, live streaming may lag and not be very
smoothly. If you enable this option, the live streaming will be stored on the client PC’s cache memory
for a few seconds before being played on the client computer’s live view window. This helps produce
a smoothlier live streaming. If you enter a vlue of 3,000 milliseconds, the streaming will delay for 3
seconds.



Configuration

Click Configuration on the main page to enter the camera setting pages. Note that only
Administrators can access the configuration page.

The following is the interface of the main page:

Home Client settings JOGHIGITETGLE Language

System > General settings
System Navigation Area
System

General settings Host name: IMega-Pixel Network Camera

Homepage layout
page fay [] Turn off the LED indicator

Logs

Parameters System time

Maint
aintenance Time zone:  GMT+08:00 Beiing, Chongging, Hong Kona, Kuala Lumpur, Singapore, Taiueig

Media Mote: You can upload your daylight =aving time rules on Maintenance page or use the camera default
value.
Network

@ Keep current date and time
Security ©) Synchronize with computer time
PTZ @ Manual

) Automatic
Event

Applications

Configuration List

Recording

Storage

Version: 0100a Firmware Version

Each function on the configuration list will be explained in the following sections.

The Navigation Area provides access to all different views from the Home page (for live viewing),
Configuration page, and multi-language selection.
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System > General settings

This section explains how to configure the basic settings for the Network Camera, such as the
host name and system time. It is composed of the following two columns: System and System
Time.

System
SyStem Host name: Mega-Pixel Metwork Camera

[]Turn off the LED indicator

Host name: Enter a desired name for the Network Camera. The name will be displayed at the top center
of the main page.

Turn off the LED indicator: Click to disable the onboard LEDs.
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System time

System time
Time zone:

GMT+08:00 Beijing, Chongging, Hong Kong, Kuala Lumpur, Singapore, Taipei, Irkutsk

[«

() Keep current date and time
(_)Synchronize with computer time
() Manual
(@) Automatic
NTF server: pool.ntp.org

Updating interval: One hour ||

Save

Keep current date and time: Select this option to preserve the current date and time of the Network
Camera. The Network Camera’s internal real-time clock maintains the date and time even when the
power of the system is turned off.

Synchronize with computer time: Select this option to synchronize the date and time of the Network
Camera with the local computer. The read-only date and time of the PC is displayed as updated.

Manual: The administrator can enter the date and time manually. Note that the date and time format are
[yyyy/mm/dd] and [hh:mm:ss].

Automatic: The Network Time Protocol is a protocol which synchronizes computer clocks by periodically
querying an NTP Server.

NTP server: Assign the IP address or domain name of the time-server. Leaving the text box blank
connects the Network Camera to the default time servers. The precondition is that the camera must
have the access to the Internet.

Update interval: Select to update the time using the NTP server on an hourly, daily, weekly, or monthly
basis.

Time zone : Select the appropriate time zone from the list. You can scroll down on the Time zone menu to
find the Customize option and use the POSIX TZ variables. For example, http://www.gnu.org/software/

libc/manual/html_node/TZ-Variable.html.

Time zone:
Customize

POSIX TZ: 'WGT3

[

Enable daylight saving time
Starting time:

Ending time:

Here are some examples for TZ values, including the appropriate Daylight Saving Time and its
dates of applicability. In North American Eastern Standard Time (EST) and Eastern Daylight
Time (EDT), the normal offset from UTC is 5 hours; since this is west of the prime meridian,
the sign is positive. Summer time begins on March’s second Sunday at 2:00am, and ends on
November’s first Sunday at 2:00am. EST+5EDT,M3.2.0/2,M11.1.0/2

Israel Standard Time (IST) and Israel Daylight Time (IDT) are 2 hours ahead of the prime
meridian in winter, springing forward an hour on March’s fourth Thursday (i.e., on the first Friday
on or after March 23), and falling back on October’s last Sunday.

IST-2IDT,M3.4.4,M10.5.0



Western Argentina Summer Time (WARST) is 3 hours behind the prime meridian all year.
There is a dummy fall-back transition on December 31 at 25:00 daylight saving time (i.e., 24:00
standard time, equivalent to January 1 at 00:00 standard time), and a simultaneous spring-
forward transition on January 1 at 00:00 standard time, so daylight saving time is in effect all
year and the initial WART is a placeholder.

The format is TZ = local_timezone,date/time,date/time.
Here, date is in the Mm.n.d format, where:

Mm (1-12) for 12 months
n (1-5) 1 for the first week and 5 for the last week in the month
d (0-6) 0 for Sunday and 6 for Saturday

CST6CDT is the name of the time zone

CST is the abbreviation used when DST is off

6 hours is the time difference from GMT

CDT is the abbreviation used when DST is on
,M3 is the third month

.2 is the second occurrence of the day in the month
.0 is Sunday

/2 is the time

,M11 is the eleventh month

.1 is the first occurrence of the day in the month
.0 is Sunday

/2 is the time

The minimum specifier is down to the hour.



System > Homepage layout

This section explains how to set up your own customized homepage layout.

General settings

This column shows the settings of your hompage layout. You can manually select the background and
font colors in Theme Options (the second tab on this page). The settings will be displayed automatically
in this Preview field. The following shows the homepage using the default settings:

General settings || Theme options

_____________

Profile name: IE: v
Digital output

# Manual trigger:

1 !
# Client settings \E\ @@@@

Fowered by % yivaTEK

[7] Hide Powered by VIVOTEK

m Hide Powered by VIVOTEK: If you check this item, it will be removed from the homepage.

Logo graph
Here you can change the logo at the top of your homepage.
Logo graph

A customized logo (Gif, JPG or PNG) can be uploaded for main page. Itwill be resized to
160x50 pixels to replace the previous logo.

O Default & Custom

Yviverk  Yviverk

Lago link: | hitp:fivsase vivotek.com

Browze. ..

Follow the steps below to upload a new logo:

1. Click Custom and the Browse field will appear.

2. Select a logo from your files.

3. Click Upload to replace the existing logo with a new one.
4. Enter a website link if necessary.

5. Click Save to enable the settings.

Customized button
If you want to hide the manual trigger buttons on the homepage, please uncheck this item. This item is
selected by default.

Customized button

Show manual trigger button

Save



Theme Options

Here you can change the color of your homepage layout. There are three types of preset patterns for you
to choose from. The new layout will simultaneously appear in the Preview field. Click Save to enable the

settings.
General settings | Theme options
Y VIVOTEK  Mega-Pixel Network
Font Color Profile name: [T v
Background Color of the Digital output
Control Area ¥ Manual trigger:
Font Color of the
Configuration Area :
Background Color of the e
Configuration Area
Themes Color
Font color: #000000
@ Font color of configuration area:
® | a #FFFFFF
Preset patterns Font color of video title: -
Bk color of control area: #CAEAFF
p— . Bk color of configuration area: -
| ] BEk color of video area: #CAEAFE

Custom Frame color: -

Save

General settings | Theme options

Video stream 1~ A - -
Digital output il . :ﬁ?‘.—- !

# Manual trigger:

ol(ul[s]lo]sa il

General settings | Theme options

Mega-Pixel Network

Video stream
Digital output m

|

'.-f"\". .

Manual trigger:

\8
' == ke )
b i ‘. Eoe

o u]s]o sl Dl

o by ¥ wiveTER

Font Color of the
Video Title

Background Color of
the Video Area

Frame Color



m Follow the steps below to set up a custom homepage:
1. Click Custom on the left column.
2. Click to select a color on on the right column.

Themes Color
Font color:
" Font color of configuration area: #FFFFFF
- ’

Color Selector
Font color of video title:

BK color of control area:

- - Bk color of configuration area:
[ —
| | _ Bk color of video area:
Custom o  Custom Frame color:
Pattern

3. The palette window will pop up as shown below.

Green: l:l Green: E
Blue: l:l Blue: E
Hue: l:l Hue: IE
Saturation: l:l Saturation; IE
Yalue: l:l \\Lalue: ’F)
T

4. Drag the slider bar and click on the left square to select a desired color.

5. The selected color will be displayed in the corresponding fields and in the Preview column.
6. Click Save to enable the settings.



System > Logs

This section explains how to configure the Network Camera to backup system log to a remote

server.

Log server settings

Log server settings
v| Enable remote log
IP address

port

514

Save

Follow the steps below to set up the remote log:

1. Select Enable remote log.

2. In the IP address text box, enter the IP address of the remote server.
2. In the port text box, enter the port number of the remote server.

3. When completed, click Save to enable the setting.

You can configure the Network Camera to send the system log file to a remote server as a log backup.

Before utilizing this feature,

it is suggested that the user install a log-recording tool to receive system log

messages from the Network Camera. An example is Kiwi Syslog Daemon. Visit http://www.kiwisyslog.
com/kiwi-syslog-daemon-overview/.

System log

B Kii Syslog Service Manager (30 Day trial - Version 9.2] [=[E [t
File Edit View Manage Help
FmA® Display 00 [Default) - 30 Days leftin evalustion
Dale Time: Prioiity Hostname  Message B
06-27-2011 17:08:48 Sysloginfo  192168.4103 syslogd 1.5.0: restart
06-27-2011 17:06:57 User.Info 192.168.4.103 [RTSP SERVER] Stop one session. IP=192.168.4.101
06-27-2011 17:06:57 Userdnfo 192.168.4.103 last message repeated 2 times
06272011 17:06:13 Userdnfo 192.168.4.103 [RTSP SERVER]. Start one session, IP=192.168.4.101
06-27-2011 17:06:12 User.Emor 192.168.4.103 [RTSP SERVER] sic/session_mgr_function.c-750. XMLSParser_Readall File #var/run/sessioninfo failed!™M
06-27-2011 17:06:12 Userdnfo 192.168.4.103 [RTSP SERVER]. XMLSParser: junk after document clement at ine 6°M
06-27-2011 17:06:12 User.Info 192.168.4.103 [RTSP SERVER] Stop one session. IP=192.168.4.101
06-27-2011  17:06:12 User.Info 192.168.4.103 [RTSP SERVER]: Stop one session, IP=192.168.4.101
06-27-2011 17:06:10 UserNotice  192168.4.103 [UPNP DEVICE]: Process exit
06-27-2011 17:06:08 User. Notice 192.168.4.103 [DRM Service]: Starting DRM service.
06-27-2011  17:06:07 User.Info 192.168.4.103 [swatchdog]: Ready to watch hitpd.
06-27-2011 17:06:06 Dacmon.Notice 1921684103 udhcpc: dns 192.168.0.10 192.168.0.20
06-27-2011 17:06:06 Daemon Notice 192.168.4.103 udhcpc: router 192.168.4.1
06-27-2011 17:06:05 Daemon Motice 192.168.4.103 udhcpe: IP 192.168.4.103 netmask 255255 265.0
NRO79M1 A7-NRNT MemrWaminn 192182 4102 [FUENT MRRY the niarese of avent 81 s skinned horanea f lnw nrinsitn

This column displays the system log in chronological order. The system log is stored in the Network
Camera’s buffer and dated events will be overwritten when the number of events reaches a limit.

System log | | Access log
Apr 14 19:17:18 automount[8677]:
No such file or directory

Apr 14 19:17:18 automount[8677]:
on /mnt/auto/CF

Apr 14 19:17:19 automount[8680]:
No such file or directory

Apr 14 19:17:19 automount[8680]:
on /mnt/auto/CF

Apr 14 19:17:20 automount[8683]:
No such file or directory

Apr 14 19:17:20 automount[8683]:
on /mnt/auto/CF

Set parameter log

VADP log

>> mount: mounting /dev/localstoragep1 on /mnt/auto/CF failed:
mount(generic): failed to mount /dev/localstoragep1 (type auto)
>> mount: mounting /dev/localstoragep1 on /mnt/auto/CF failed:
mount(generic): failed to mount /dev/localstoragep1 (type auto)
>> mount: mounting /dev/localstoragep1 on /mnt/auto/CF failed:

mount(generic): failed to mount /dev/localstoragep1 (type auto)

Apr 14 19:17:21 [VcaTracker]: WARN : ---
Apr 14 19:17:21 [VcaTracker]: WARN : ---
Apr 14 19:17:21 automount[8693]: >> mount: mounting /dev/localstoragep1 on /mnt/auto/CF failed:
No such file or directory

Apr 14 19:17:21 automount[8693]: mount(generic): failed to mount /dev/localstoragep1 (type auto)
on /mnt/auto/CF

Apr 14 19:17:21 [VcaTracker]: WARN : yuver capture size: [1472,1472]

Apr 14 19:17:22 automount[8697]: >> mount: mounting /dev/localstoragep1 on /mnt/auto/CF failed:
No such file or directory

Apr 14 19:17:22 automount[8697]: mount(generic): failed to mount /dev/localstoragep1 (type auto)
on /mnt/auto/CF

Apr 14 19:17:23 automount[8700]: >> mount: mounting /dev/localstoragep1 on /mnt/auto/CF failed:
No such file or directory

Apr 14 19:17:23 automount[8700]: mount(generic): failed to mount /dev/localstoragep1 (type auto)
on /mnt/auto/CF

-StateFrameBegin Reload: Normal:(144)
-StateSaveVcaConfig Reload: Normal:(144)-

v


http://www.kiwisyslog.com/kiwi-syslog-daemon-overview/
http://www.kiwisyslog.com/kiwi-syslog-daemon-overview/

VIVOTEK

You can install the included VAST recording software, which provides an Event Management
function group for delivering event messages via Emails, GSM short messages, onscreen event
panel, or to trigger an alarm, etc. For more information, refer to the VAST User Manual.
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Access log

Systemn log || Access log || Set parameter log | | VADP log

Jan 5 11:36:28 [RTSP SERVER]: Start one session, IP=172.16.2.52
Jan 5 11:49:15 [RTSP SERVER]: Start one session, IP=192.168.4.105
Jan 5 13:11:20 [RTSP SERVER]: Start one session, IP=192.168.4.105

Access log displays the access time and IP address of all viewers (including operators and
administrators) in a chronological order. The access log is stored in the Network Camera’s buffer
area and will be overwritten when reaching a certain limit.

Set Parameter log

VADP log contains the history of changes made to system parameters such as recording, imaging
parameters, and all other parameters.

VADP log

VADP log contains the information for the onboard VADP packages, including memory usage, module
load and unload information.

System log | Access log | | Set parameter log | VADP log

Jan 14 20:22:30 VADP]: Jan 14 20:22:30 [VADP]: File system disk space usage Jan 14 20:22:30

MWADP): Filesystem Size  Used Available Use% Mounted on Jan 14 20:22:30 [WADPT: )
ubi1:flashis2 323 42M 26.4M 14% fmntflash2 Jan 14 20:22:30 [VADP]
""""""""""""""" Jan 14 20:22:30 MVADP].  Start to upgrade preload package

Jan 14 2002230 [VADP], s Jan 14 20:22:30 MADP]: Preload

package Size: 3.2M Jan 14 20:22:32 [WADP]: Untar package Size: 6.9M Jan 14 20:22:32 MMADPY:
Trend Micro loT Security Preload Package Version: 1.1b.a1.7.5 Jan 14 20:22:41 WADP]: Update
configuration... Jan 14 2002242 [VADP]: Jan 14 20:22:42 NADP]: Trend Micro loT Security is
stopped Jan 14 20:22:43 [WADP]: File system disk space usage Jan 14 20:22:43 [WADP]: Upograde

Filesystem Size  Used Available Use Mounted on Jan 14 20:22:43 [VADP]: Before
ubii:flashis2 323 1AM 28.5M 3% /mntflash2 Jan 14 20:22:43 [VADP): After
ubi1:flashfs? 323 6.0M  24.6M 20% 'mntflash2 Jan 14 20:22:43 [VADP]: File space

usage: Jan 14 20:22:43 WADP]: Upgrade 3Size PathJan 14 20:22:43 MMADP]: Before O.Jan 14
20:22:43 VADPT After  6.9M  /mntMash2ivadp0 Jan 14 20:22:43 [WADF]: Uparade preload
Trend Micro loT Security package successiully Jan 14 20:22:43 WADP]: Jan 14 20:22:43 VADPT:
FPreload package Size: 1.0M Jan 14 20:22:43 [WADP]: Untar package Size: 2.3M Jan 14 20:22:44
ADF]: Stratocast Preload Package Version: 1.1b.a1.4.2 Jan 14 20:22:50 MWADF): Update
configuration... Jan 14 20:22:57 [WVADP]: Jan 14 20:22:57 MWADFP]: File system disk space usage

Jan 14 20:22:53 MADP]: Upgrade Filesystem Size  Used Available Use% Mounted on
Jan 14 20:22:53 [MADP]: Before ubil:flashfs2 323 50M  256M 16% /mntflash2
Jan 14 20:22:53 [VADP]: After  ubil:flashfs2 323 6.5M 24.0M 21% /mntflashz Jan

14 20:22:58 [WADPI: File space usage: Jan 14 20:22:58 [VADP]: Upgrade Size PathJan 14
20:22:58 [VADP]: Before 0.Jan 14 20:22:58 [WVADP]: After  2.3M  /mntfash2ivadp/ Jan 14
20:22:58 [WADPT Upgrade preload Stratocast package successfully Jan 14 20:22:58 [WADF]: Jan

14 202258 PVADR ] R A Jan 14 20:22:58 MWADP]:  Upagrade
preload package end Jan 14 202258 WA D P, o e Jan 14
20:22:58 [WADP] File system disk space usage Jan 14 20:22:53 [WADP]: Filesystem Sire v

Used Available Use% Mounted on Jan 14 20:22:538 NWADPIL: ubil:flashfs2 32.3M 6.5M



VIVOTEK

System > Parameters

The View Parameters page lists the entire system’s parameters in an alphabetical order. If you
need technical assistance, use a text-editor program to copy and save the parameters listed on
this page. Send the parameter text file to VIVOTEK'’s technical support.

— Parameters

system hostname='FE9391-EHV-v2'

system ledoff='0"

system lowlight="1"

system date='2021/09/15"

system time='10:55:20"

system datetime='091509262021.01"

system ntp=""

system daylight enable='0"

system daylight auto begintime='Not Support'
system daylight auto endtime='Not Support'
system daylight timezones=',6-360,-320,-280,-240,-241,-200,-140,-121
system updateinterval='0"

system info modelname='FE9331-EHV-v2'

system info extendedmodelname='FE9391-EHV-v2'
system info serialnumber='0002D1985096"
system info firmwareversion='FE9391 vZ2-VVTK-1.2101.37.01d'
system info language count="10"'

system info language i0='English'

system info language il='Deutsch'

system info language iZ2='Espafiol'

system info language i3='Francais'

system info language id='Italiano'

system info language i5='HAZE'

system info language ié='Portugués'

system info language i7='fE{EH"

system info language i8="%gEHI7"

system info language i9='Pyccruii'

system info language il0=""'

system info language ill="'

system info language il2=""
mrrmid A e T v e S12 11
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System > Maintenance

This chapter explains how to restore the Network Camera to factory default, upgrade firmware
version, eftc.

General settings > Upgrade firmware
Upgrade firmware

Select firmware file: [ Upgrade ]

This feature allows you to upgrade the firmware of your Network Camera. It takes a few minutes to
complete the process.
Note: Do not power off the Network Camera during the upgrade!

Follow the steps below to upgrade the firmware:

1. Download the latest firmware file from the VIVOTEK website. The file is in .pkg file format.

2. Click Browse... and specify the firmware file.

3. Click Upgrade. The Network Camera starts to upgrade and will reboot automatically when the upgrade
completes.

If the upgrade is successful, you will see “Reboot system now!! This connection will close”. After that, re-
access the Network Camera.

The following message is displayed when the upgrade has succeeded.

Reboot system now!!
This connection will close.

The following message is displayed when you have selected an incorrect firmware file.

'd N\
Starting firmware upgrade...
Do not power down the server during the upgrade.
The server will restart automatically after the upgrade is
completed.
This will fake about 1 - 5 minutes.
Wrong PKG file format
Unpack fail

(. J

General settings > Reboot

Reboot

This feature allows you to reboot the Network Camera, which takes about one minute to complete. When
completed, the live video page will be displayed in your browser. The following message will be displayed
during the reboot process.

The device is rebooting now. Your browser will reconnect to hitp:/192.168.5.151:80/
[fthe connection fails, please manually enter the above IP address in your browser.

If the connection fails after rebooting, manually enter the IP address of the Network Camera in the
address field to resume the connection.



General settings > Restore

Restore

Restore all setiings fo factory default except seftings in

[] Metwork [ ] Daightsaving ime [ ] Custom language [ ]| VADP | Resftore

This feature allows you to restore the Network Camera to factory default settings.

Network: Select this option to retain the Network Type settings (please refer to Network Type on page
93).

Daylight Saving Time: Select this option to retain the Daylight Saving Time settings (please refer to
Import/Export files below on this page).

Custom Language: Select this option to retain the Custom Language settings.

VADP: Retain the VADP modules (3rd-party software stored on the SD card) and related settings.

If none of the options is selected, all settings will be restored to factory default. The following message is
displayed during the restoring process.

The device is rebooting now. Your browser will reconnect to hitp:/M192.168.5.151:.80/
[fthe connection fails, please manually enter the above IP address in your browser.

Import/Export files

This feature allows you to Export custom language file, and configuration file.

General settings | | Import/Export files

Export files

Export language file

Export configuration file

Export server status report

Upload files

Update custom language file:
Upload configuration file:



The following message is displayed when attempting to upload an incorrect file format.

Microsoft Internet Explorer, @

! ‘j The File must hawve a .xmil filenanne suffix,

—

Export language file: Click to export language strings. VIVOTEK provides nine languages: English,
Deutsch, Espariol, Frangais, Italiano, P # 3, Portugués, f§{KkH3Z, and %48 ¢ <.

Update custom language file: Click Browse... and specify your own custom language file to upload.

Export configuration file: Click to export all parameters for the device and user-defined scripts.

Export server staus report: Click to export the current server status report, such as time, logs,
parameters, process status, memory status, file system status, network status, kernel message..., and so
on.

-‘@’- Tips:

+ If a firmware upgrade is accidentally disrupted, say, by a power outage, you still have a last resort
method to restore normal operation. See the following for how to bring the camera back to work:

Applicable scenario:

(1) Power disconnected during firmware upgrade.
(2) Unknown reason causing abnormal LED status, and a Restore cannot recover normal working
condition.

You can use the following methods to activate the camera with its backup firmware:

(1) Press and hold down the reset button for at least one minute.

(2) Power on the camera until the Red LED blinks rapidly.

(3) After boot up, the firmware should return to the previous version before the camera hanged. (The
procedure should take 5 to 10 minutes, longer than the normal boot-up process). When tthis
process is completed, the LED status should return to normal.



Media > Image

This section explains how to configure the image settings of the Network Camera. It is
composed of the following tabbed windows: General settings, Image settings, Exposure, and
Privacy mask, and Pixel Calculator.

General settings | | lluminators | | Image settings | Exposure | | Privacy mask | Pixel calculator
General settings Video settings

Video title

[[] Show timestamp and video title in video and snapshots

Position of timestamp and video title an image: Top  [v]

Timestamp and video title font-size: 30[v]

Video fant () Default v]
Mount type ®) Ceiling () Wall () Floar

Color: () BAV (e Color

Power line frequency ()50 Hz (@ 60 Hz

Video orientation: [] Flip [] Mirror

Day/Night settings
Switch to BAV in night mode
IR cutfilter: Auto mode [~

Sensitivity of IR cut fiter: Normal [v]

Select auto mode will disable profile of exposure settings.

Save

Video title: Enter a name that will be displayed on the title bar of the live video as well as the view cell on
the VAST recording software.

Show timestamp and video title in videos and snapshots: Enter a name that will be displayed on the title
bar of the live video as the picture shown below.

Position of timestamp and video title on image: Select to display time stamp and video title on the top or
at the bottom of the video stream.

Timestamp and video title font size: Select the font size for the time stamp and title.

Video font (.ttf): You can select a True Type font file for the display of textual messages on video.

Mount type: There are 3 Mount types - Ceiling, Wall, and Floor.
Ceiling: The Ceiling mount type automatically delivers upside-down images. The Ceiling mode
supports the following Display modes - 10, 1P, 1R, 2P, 103R, 4R, 4R PRO, and 108R.
Wall: The Wall mount type applies to the monitoring of long, side-to-side surveillance areas, such
as when mounted on a wall facing a corridor. Different Mount types have different options with the
Display mode settings. For example, the 1P2R (1 Panoramic & 2 Regional) and 1P3R (1 Panoramic
& 3 Regional) display modes are only available when the “Wall* Mount type is applied.

Floor: The Display modes with the Floor mount type are identical to those for the Ceiling mount
except that the images are not vertically flipped.



Color: Select to display color or black/white video streams.

Power line frequency: Set the power line frequency consistent with local utility settings to eliminate image
flickering associated with fluorescent lights.

Video orientation: Flip - vertically reflect the display of the live video; Mirror - horizontally reflect the
display of the live video. Select both options if the Network Camera is installed upside-down (e.g., on the
ceiling) to correct the image orientation. Please note that the preset locations will be cleared after you
configure the flip/mirror option.

Day/Night settings

Day/Night
| Switch to BAV in night mode

Turn on external IR illuminator in night mode

IR cut filter: Auto mode E|

Sensitivity: Normal (=]

Select auto mode will disable profile of exposure settings.

Switch to B/W in night mode
Select this checkbox to enable the Network Camera to automatically switch to Black & White display
during the night mode.

IR cut filter
With a removable IR-cut filter, this Network Camera can automatically remove the filter to let Infrared light
pass into the sensor during low light conditions.

m Auto mode (The Day/Night Exposure Profile will not be available if Auto mode is selected)
The Network Camera automa